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Chapter 1.  Introduction 

 

ProCapture Motion Capture Solutions are built on Xcitex’s award winning ProAnalyst® 

software. By adding a front-end motion capture system that can capture live video from up 

to 8 cameras and up to 32 channels of data collection from a variety of sensors and force 

plates, users can build a low-cost, high performance live video motion capture solution. 

With cameras controlled by the ProCapture video/data capture software, a complete 

motion event can be captured, downloaded and analyzed in ProAnalyst. 

ProCapture systems include cameras, a video processing unit, and software. All cameras 

and data channels are automatically synchronized. Images and data are streamed directly 

to recording drives on the Video Processing Unit for up to 5 hours of continuous recording. 

Cameras are optimized for both visible and infrared applications. When each recording is 

complete, the ProCapture software creates ProAnalyst projects for analysis. 

Highlights of the ProCapture system include: 

• Up to 5 hours of continuous recording 

• 5 to 1000 fps high resolution cameras 

• Synchronize multiple cameras with up to 32 channels of data collection 

• Suitable for 2-D and 3-D video-based motion analysis 

How this User Guide is Organized 

Chapter 1 – Introduction gives an overview of ProCapture and discusses the hardware 

and software components of the system. 

Chapter 2 – Quick Start Guide provides typical examples of configuration, recording, 

event marking, reviewing, and saving videos. 

Chapter 3 – ProCapture Software Interface describes the toolbars, menus, and 

functions of the ProCapture software interface. 

Chapter 4 – Configuring a Recording details configuration settings and their effects on 

your recordings. 

Chapter 5 – Capturing Events discusses conditions to consider before recording, 

triggering options, and the process of capturing events. 
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Chapter 6 – Analyzing, Viewing, and Sharing Captured Events gives an overview of 

how to work with your captured events using ProAnalyst. 

Chapter 7 – Advanced Topics contains information on procedures that may be 

performed infrequently or only under special circumstances. 

Chapter 8 – Troubleshooting contains solutions for specific problems. 

What is Included 

All ProCapture systems include the following items: 

• ProCapture control software (pre-installed and keyed to VPU) 

• User guide 

• License agreement 

• 1 - 8 cameras with power supplies 

• Keyboard and mouse 

• Video processing unit (VPU) with 6-foot power cable 

• Trigger box 

• Hand trigger switch 

• 7-meter camera cables 

• ProAnalyst Introductory Edition software installation kit 

• ProViewer software (pre-installed) 

  

 

If you purchased a ProCapture system with data collection, you also receive: 

 

• Data acquisition hardware – 8, 16, or 32 channels  

 

 

Your ProCapture system may also include some of the following accessories: 

 

• Monitors (touch screen or conventional) 

• Mounting arms, tripods, and brackets 

• Storage drives 

• Lenses 

• Portable light kit 

• Cable repeaters 
• Fiber optic cables and converters 
• Calibration fixture  
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Hardware Installation and Connections 

This section describes the hardware components that are included with your ProCapture 

system and includes diagrams and procedures for connecting them. 

 

Xcitex Cameras 
The Xcitex XC-1 camera is ideal for the capture of human motion, animal locomotion, 

machinery, robotics and similar applications. Each camera measures 60 mm x 60 mm x 

45 mm (2.4" x 2.4" x 1.4"), making it easy to install on walls, tripods, production lines, or 

into tight spaces. The 1248 x 1082 (1.3 Mpixels) sensor can achieve 170 frames per 

second recording speed at full resolution, with a maximum rate of 500 frames per second 

at reduced resolution. 

 

The next-generation Xcitex XC-2 camera is available in color or monochrome versions 

and is even smaller than the XC-1, measuring 55 mm x 55 mm x 42 mm. Featuring a 2.1 

Megapixel sensor, the XC-2M/C provides high definition with a maximum of 1000 fps and 

resolutions up to 1920 x 1080 pixels at 60 fps. Optimized for low-light situations, this 

camera is ideal for industrial applications where high sensitivity and high frame rates are 

required. 

 

Video Processing Unit (VPU) 
The Video Processing Unit (VPU) is a specialized computer containing frame grabbers, 

data acquisition hardware, and storage devices. The housing is sturdy and portable for 

use in the field or in the lab. The operating system (Windows 7, 64-bit version) and 

ProCapture, ProAnalyst, and ProViewer software packages are installed by default on the 

C: drive. Drives E: through L: are assigned to each camera included with your ProCapture 

system. Video and data recordings are streamed to these drives, which serve as caches. 

No files should be stored on the drives reserved for the cameras (E – L). The VPU also 

contains a 1 TB hard drive for image event storage and operating system. 

 

When the power is on, the large power button on the front of the VPU changes color to 

indicate the current state of the ProCapture system. The light glows green when cameras 

are live, red when recording, and light blue when saving. 

 

Trigger Box and Hand Trigger Switch 
The trigger box and hand trigger switch are hardware devices that allow you to trigger 

events manually during a ProCapture recording session by using a handheld switch. 
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Optional Data Collection Hardware 
ProCapture supports 8, 16, or 32 channels of data collection from sensors, force plates, 

EMG, gauges, accelerometers, etc. The data collection hardware includes PCI boards, 

dual shielded cables and BNC breakout boxes from National Instruments™, shown below. 

 

 

 PCIe Board Dual Shielded Cable BNC Breakout Box 

 

The following table shows the data collection hardware components that may be used with 

ProCapture for data acquisition. 

Part 
Number 

 

Differential 
Analog 
Inputs 

Sample Rate 
per Channel 

 

Resolution 
 

Included 
Hardware 

 

PC101-
DAQ-8-1 

8 250 kS/s 16 bit 
BNC Breakout 

Box / PCIe card 

PC101-
DAQ-16-1 

16 
1.25 MS/s or 

1.0 MS/s 
multichannel 

16 bit 

BNC Breakout 
Box & BNC 
Extended 

Breakout Box/ 
PCIe card 

PC101-
DAQ-32-1 

32 
1.25 MS/s or 

750kS/s 
multichannel 

16 bit 

BNC Breakout 
Box & BNC 
Extended 

Breakout Box / 
PCI card 

Additional configurations may be available upon request. 
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Connecting the Cameras  
Insert the camera cables into the labeled ports on the back of the VPU, as shown below. 

 

Note: The arrangement of connection ports on the VPU may be subject to change. Please 

refer to the connection port labels to confirm connection locations on your system. 
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Connecting the Trigger Box and Hand Trigger Switch 
The diagram on the following page illustrates two options for connecting the trigger box 

and hand trigger switch. 

For Option 1 (standard configuration), connect the trigger box to the BNC connector 

labeled Trigger on the back of the VPU. This allows you to use the hand switch to trigger 

events. Use Option 1 when recording with video only, or when recording video and data 

without data level triggering. 

Use Option 2 if you wish to use data level triggering to capture the trigger box signal. 

Connect the trigger box to one of the channels on the Data Acquisition box. (The diagram 

shows the trigger box connecting to Data Channel 1; however, you may connect it to any 

channel.) In this case, you should set the Data Level Trigger settings to detect a trigger 

condition where the rising edge voltage exceeds 3 volts. 

Note: For more information, refer to "Triggering", "Data Acquisition Basics", and "Data 

Level Triggering" in Chapter 5. 
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Software 

This section describes the ProCapture control software and the ProAnalyst and ProViewer 

software packages included with your ProCapture system. Procedures are provided for 

updating and reinstalling the software. 

 

ProCapture Software 
ProCapture control software is already installed on the VPU when you receive your 

ProCapture system. The ProCapture software captures live video and optionally collects 

analog and digital data. ProCapture control software provides the following features: 

 

• Simple setup – all cameras automatically initialize after software launch 

 

• Optional touch screen interface, easy to use control panel 

 

• User-controlled configurations 

 

• Create discrete, manageable events from long video streams 

 

• Variety of event triggering methods 

 

• Video and data automatically synchronized 

 

• Automatically creates ProAnalyst projects for analysis  

 

• Live view of up to 8 cameras simultaneously, spanning multiple monitors  

 

 

ProAnalyst Software 
ProAnalyst Introductory Edition software is included with your ProCapture system. 

ProCapture is designed to work with ProAnalyst, the world’s premier software package for 

automatically measuring moving objects with video. ProCapture creates project files which 

can be viewed and analyzed with ProAnalyst. ProAnalyst Introductory Edition allows you 

to automatically track one feature and manually track 32 features. You can export the 

resulting track data to Excel or MATLAB for further analysis and graphing. 

 

ProAnalyst software can be installed and licensed on multiple computers. The security key 

provided with ProAnalyst can be moved to the computer where you wish to use the 

software. ProAnalyst does not have to be installed on the ProCapture VPU.  
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ProViewer Software 
ProViewer software is pre-installed on your ProCapture system. Ideal for presentations 

and quick review, ProViewer allows you to open project files, play videos, and share them 

with others. 

Product Updates 

As ProCapture, ProAnalyst, and ProViewer are continually updated and improved, be sure 

to obtain free downloads of the most current software versions from our website at 

www.xcitex.com. Updates typically contain new features as well as bug fixes. 

 

Check for Updates 
To help you keep up to date with new software releases, we have provided a tool to check 

for recent software updates. Select Check For Updates… from the Help menu. The 

Check for Updates dialog will appear, listing the software version currently installed on 

your computer. Click the Check button to contact the Xcitex server and check for the 

latest software version available for download. 

 

 
 

If version information is successfully obtained from our server, the dialog will display links 

to the release notes and the download page for the latest available version. You may 

review the release notes by clicking on the Release Notes link. To download the latest 

version, click on the Download link and follow the instructions on the web page that 

appears.  

http://www.xcitex.com/html/downloads.php
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Reinstalling ProCapture Software 
ProCapture software is pre-installed on the VPU when you receive it. You can upgrade to 

the latest version of the software by using the Check For Updates feature on the Help 

menu. 

 

To install the software, perform the following steps: 

 

 

1. From the Help menu, select Check for Updates. Click Check in the dialog box, 

then click the Download Link to download ProCapture software from the Xcitex 

website. If your software is up to date, the message "This is the most recent 

version, you do not need to update at this time" appears at the bottom of the 

dialog box. 

 

 

2. The ProCapture Setup Wizard screen will appear. Click Next. 

 

 

 

 

3. On the License Agreement screen, select I accept the agreement and click 

Next.  
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4. Select the destination folder for your ProCapture files. Click Next. 

 

Note: The default folder is C:\Program Files\Xcitex\ProCapture. You are advised 

to use this folder for automatic updates. 

 

 

5. The Select Start Menu Folder screen will appear with ProCapture selected. The 

program's shortcuts will be created in this folder. Click Next. 

 

 

6. The Select Additional Tasks screen appears, with all tasks selected. You may 

deselect tasks by clicking to clear the checkboxes. ProCapture Setup will not 

perform any tasks that are not selected. If you are updating an existing 

installation, all checkboxes can usually be unchecked to speed the installation. 

 

 

 

 

7. Click Install at the Ready to Install screen to begin installing ProCapture 

software. A status bar will appear during the installation process. 
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8. Install or repair Microsoft Visual C++ runtime libraries, if requested. 

 

 

9. Install or repair the SafeNet Sentinel HASP application, if requested. 

 

 

10. Install device drivers, if necessary. 

 

 

11. Click Finish at the Completing the ProCapture Setup Wizard screen to complete 

the installation. 
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Chapter 2.  Quick Start Guide 

 

This chapter provides a walk-through for configuration, recording, event marking, 

reviewing, and saving videos. Two examples are provided: video only and video with data. 

Factors to consider before recording video are also discussed. 

Pre-Capture Considerations 

Several factors affect the quality and usability of the videos that you record with 

ProCapture. When recording your video, be aware of the following: 

• Lighting, shadows, shiny objects 

• Markers (white on black or vice versa) 

• Contrast 

• Movement in background 

• Frame rate 

• Resolution 

• Shutter speed 

After videos are downloaded to ProAnalyst, you can use image processing and filtering to 

improve the video images for tracking. For more information, please refer to the 

ProAnalyst User Guide. 
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Video Example 
 

The following example shows how to use ProCapture to acquire high-speed video of a test 

subject jumping. We will record the subject at 150 frames per second (fps) and save 3-

second segments of video around each event of interest. 

 

1. Double-click the ProCapture shortcut on your desktop to launch the program. The 

cameras start up automatically, ready to record. 

 

 

 

 

2.  In the Control panel on the right, click Configure.   
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3. Since we are only recording video in this example, select Synchronized Video from 

the Program Options control panel. 

 

 
 

 

 

4. Click Video to display the Video Acquisition Settings panel. Select 150 as the Frame 

Rate, enter 3000 microseconds as the Default Shutter Speed, and select the highest 

resolution available as the Default Resolution. 

 

 
 

 

 

5. In our example, we expect that interesting events would last approximately 3 

seconds. We also plan to mark each event (click the trigger button) in the middle of 

the event, so click Event Save and enter 1.5 seconds as the Pre-Event Save 

Duration and Post-Event Save Duration. We could also mark each event after it has 

completed, in which case we might want to increase the Pre-Event Save Duration to 3 

seconds and decrease the Post-Event Save Duration to 0 seconds. 
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6. Select AVI from the Type dropdown menu. Leave all other options at their default 

settings. 

 

 

 

7. Using the settings shown above, ProCapture will bookmark each triggered event and 

save a total of 3 seconds of video: 1.5 seconds before the event, and 1.5 seconds 

after it when saving all events after the recording has completed. 

 

 

8. Click OK at the bottom of the window to save the configuration settings for all panels. 
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9. Now you are ready to record the video. Click Record and have the test subject begin 

jumping in view of the cameras. 

 

 

 
 

 

 

10. Click the Event Trigger button (or press the hand trigger switch if connected to your 

system) when something interesting occurs. You can click Event Trigger as many 

times as you wish. The Event Count on the screen will increase each time the trigger 

is pressed.  
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11. When you have finished recording, click Stop/Idle. The entire test period from when 

you began recording is now stored on the local camera drives. You can either save 

the entire recording or only save the time around each event of interest. Saving the 

entire recording can generate very large video files and is not recommended in 

general. 

 

 

12. Click Save All Events to create 3-second .avi video files for each camera view of 

each triggered event. The 3-second duration is set from the Event Save Settings 

configuration panel. To save more or less time around each triggered event, click 

Configure, update the save values, and click Save All Events again. 
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13. To verify that your events were recorded, run ProAnalyst or ProViewer to view the 

video captures. Double-click the ProAnalyst or ProViewer shortcut on your desktop 

to launch the program. 

 

 

14. In ProAnalyst or ProViewer, use the File menu and select Open from ProCapture to 

see the recently saved events. Review the saved events to ensure that the events of 

interest were successfully captured. If you need to change the amount of time saved 

before and/or after each event marker, see "Changing the Save Range after 

Recording" in Chapter 5. 

 

 

 

Video/Data Example 

This example demonstrates the value of using ProCapture to acquire high-speed video 

and sensor data at the same time. In this example, an accelerometer measures forces, 

while video captures the amount of motion. You will use ProCapture to capture and 

display video motion of a moving object in conjunction with sensor data. 

 

 

1. Double-click the ProCapture shortcut on your desktop. The cameras start up 

automatically, ready to record. 

 

 

2. Click Configure and select Synchronized Video and Data from the Program 

Options panel. 
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3. Click Video and select 100 as the Frame Rate, enter 9500 microseconds as the 

Default Shutter Speed, and select the highest resolution available as the Default 

Resolution. 

 

 
 

 

4. Click Data to configure a data channel for the accelerometer. 

 

 

5.  Set the Number of Channels to 1. 

 

 

6. Enter 10 for Samples Per Frame and 1000 for Live Samples to Display.  
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7. Click Event Save and enter 1.5 seconds as the Pre-Event Save Duration and Post-

Event Save Duration. Select AVI from the Type dropdown menu. Leave all other 

options at their default settings.  

 

 

 

 

 

8. Click OK at the bottom of the window to save all the configuration settings. 
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9. For this example, we have attached the accelerometer to a long, flexible ruler. 

 

 

 

 

10. The cameras are now in Live mode. Hold the ruler at the end and bend it downward 

and release. The ruler will spring back up and oscillate. Check to see that the ruler is 

in the view of each camera, and that data is being read from the accelerometer. 

 

 

11. Click Record. Resume moving the ruler, and click Event Trigger to create an event 

marker. You may create as many event markers as you wish. 

 

 

12. When you are finished recording, click Stop/Idle. 

 

 

13. Click Save All Events to create .avi video files for each camera view of the single 

event. 

 

 

14. Launch ProAnalyst or ProViewer and select Open from ProCapture from the File 

menu to view the videos of your recorded events.  
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Additional References 
 

You now know how to conduct a simple recording session and save the resulting videos. 

For more information about the following topics, please refer to the chapters listed below. 

 

 Configuration  Chapter 4 

 Triggering  Chapter 5 

 Recording  Chapter 5 

 Data Recording  Chapter 5 

 Data Level Triggering  Chapter 5 

 Event Saving  Chapter 5 

 Changing Save Range after Recording  Chapter 5 

 Video Triggering  Chapter 5 

 Calibration  Chapter 7 
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Chapter 3.  ProCapture Software Interface 

 

The ProCapture interface is similar to many other Windows-based programs. This chapter 

covers the functions of the windows, toolbars, and on-screen information of the program in 

detail. This chapter also describes the functions available from the ProCapture control 

panel. 

ProCapture Window 

The ProCapture window displays a view from each camera. There is a panel at the bottom 

of the window that either updates the event count as events are triggered during a 

recording session (if recording video only) or displays live data graphs and channels (if 

recording video with data). 
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Camera Views 
These panels show the live view from each camera. Double clicking in any camera view 

allows you to display only the view from that camera. While in this single camera display 

mode, you can pan and zoom to ensure good focus. To go back to the multi-camera 

display, double-click in the window.  

The data graph behaves similarly. Double-clicking in the data graph will enlarge the graph 

display to occupy one quarter, one half, or three quarters of the display area; however, 

you cannot zoom and pan the data display.  

 

Pop-out Camera Views 
To open a separate window displaying the view from any camera, select View ► Pop-out 

Camera View ► (desired camera) from the Menu bar at the top of the screen. You can 

maximize, minimize, or close this window at any time. You can also pan and zoom the 

view in each of these pop-out views. 

 

Panning and Zooming in the Camera Views 
Zoom, pan, and full screen display functions are available for any camera view, including 

pop-out views. Double-click on any pop-out window to display a full-screen view from that 

camera. Within each window, you can do the following: 

• Use the mouse wheel to zoom in and out. 

 

• Click the left mouse button while dragging to pan. 

 

• Double-click to reset the display after zooming/panning or return to the multiple-

camera display. 

 

• Hold down the Ctrl key and double-click to display a pop-out camera view in a 

separate window. 

 

• In a pop-out window, you can set the display to occupy the full-screen by double-

clicking. To exit from the full screen mode, double-click again. 
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Color Correction in the Camera Views 
Several functions are available for adjusting color cameras.  To display the Color 

Conversion Parameters dialog as shown below, select Tools ► Color Correction ► 

(desired color camera) from the Menu bar at the top of the screen. 

 

 
 

 

The Presets dropdown menu allows you to load a group of preset parameters: Tungsten, 

Halogen, Daylight, Xenon, Metal, or None. Use the sliders to adjust Red, Green, and Blue 

gains and offset values, or enter the desired value into the box to the right of each slider. 

Apply Smoothing and/or Sharpening if desired. Two tools are available to assist in setting 

gains and offsets: Auto Balance and Grey Balance. For Auto Balance, simply click the 

Auto Balance button. For Grey Balance, place a grey object within the camera's field of 

view and click the Grey Balance button. 

The buttons at the bottom allow you to load a previously saved set of parameters, save a 

set of parameters, or reset to the default values. Click Store for this Camera to save this 

set of parameters so that it is automatically reloaded every time the camera is initialized. 
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Camera Gains 
ProCapture allows you to set digital and analog gain values for supported camera models. 

Analog gain occurs at the camera sensor, before image capture. Analog gain is available 

only for the XC-2 camera. Digital gain occurs after the image is captured. Digital gain may 

be set for both the XC-1 and XC-2 model cameras. To display the Camera Gains dialog 

as shown below, select Tools ► Camera Gains ► (desired camera) from the Menu bar 

at the top of the screen. 
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Image Processing 
ProCapture allows you to perform image processing to correct and enhance images for 

color and monochrome cameras. You can make basic adjustments to standard values 

such as brightness and contrast, or perform advanced adjustments by editing the 

input/output curves for each channel.  

To display the Image Processing dialog as shown below, select Tools ► Image 

Processing ► (desired camera) from the Menu bar at the top of the screen. 
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Basic Adjustment 

The Channel dropdown menu allows you to choose one of these options: Intensity, Red, 

Green, or Blue. Use the sliders to adjust Brightness, Contrast, Gamma, and Exponential, 

or enter the desired value in the box to the right of each slider.  You can also invert Red, 

Green, Blue, or All values. Click the Reset button to return to the default values. 

 

Curve Adjustment 

The Channel dropdown menu allows you to select Intensity, Red, Green, or Blue. Only the 

Intensity option is available for monochrome cameras. For color cameras, the Intensity 

channel applies changes to the Red, Green, and Blue channels simultaneously. 

 

To adjust the curve, click and drag on the point. You can add one or more points by 

clicking the desired position on the line and clicking the Add Point button. Remove points 

by clicking them and then clicking the Delete Point button.  

 

If the Smoothed checkbox is not checked, the input/output curve is generated using 

straight lines between the control points. If the Smoothed option is checked, a smooth 

spline is generated between the control points. When checked, the Histogram checkbox 

displays a histogram that changes as you adjust the curve. The Reset and Reset Chan. 

Buttons restore the default values. 

 

The buttons at the bottom allow you to load a previously saved set of parameters or save 

a set of parameters. Click Store for this Camera to save this set of parameters so that it 

is automatically reloaded every time the camera is initialized. 

 

Event/Data View 
This panel above the timeline displays the total number of events and the number of 

specific event types (software, external, video, keyboard, and data) triggered during a 

recording session. If your ProCapture system includes data acquisition, this panel displays 

a graph of the data and the available data channels. The amount of text displayed can be 

toggled with the Show Information button.  
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Timeline 
The timeline is displayed at the bottom of the ProCapture window. It represents the time 

from the start to finish of recording, or start to current time if recording is still going on. If 

events have been triggered during the recording session, a segment of the timeline is 

displayed in a specific color with a letter above the segment indicating the type of 

triggering mechanism. Pauses in the recording, data updates, and saved ranges between 

sequential events are also displayed in the timeline. Pauses are indicated by grey bars 

and ranges between sequential events are indicated by magenta bars. 

Note: For information on triggering events from the timeline, please refer to Chapter 5. 

 

Toolbars 

ProCapture software includes several toolbars. Some of them may be hidden by removing 

the checkmark next to the toolbar in the View menu. 

 

 

Title Bar 
The ProCapture title bar controls the ProCapture window. Use the controls of the title bar 

to let ProCapture run in the background (minimize it), to close the program, or to move the 

window or change its size. 

 
 

 

 

Status Bar 
At the bottom of the window, the right side of the Status bar indicates whether the Caps 

Lock, Num Lock, and Scroll Lock keys are enabled. Status messages are displayed on the 

left side. 
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Menu Bar 
The ProCapture Menu bar allows you to access universal controls and common functions 

such as configuration and changing the look of the window display. 

 

 

 

The following options are available from the Menu bar: 

 

 Configure -- Configure your ProCapture system with settings for Program 

Options, Video Acquisition, Data Acquisition, and Event Save. 

 Exit -- Exit ProCapture. 

 Note: Configuration settings are discussed in detail in Chapter 4. 

 

 Status Bar – Toggles the display of the Status bar at the bottom of the window. 

Controls – Toggles the display of the Control panel at the right side of the 

window. 

Timeline – Toggles the display of the Timeline at the bottom of the window. 

Pop-Out Camera View -- A dropdown menu allows you to display the view from 

the selected camera in a separate window. In this window, you can zoom in or 

out with the mouse wheel, pan by holding down the left mouse button while 

dragging the mouse, or reset the view and display full screen by double-clicking. 

Application Look -- The appearance of the ProCapture window can be changed 

to a variety of looks. In the Menu Bar, click on View and select Application Look 

from the dropdown menu. Select the desired window style from the list. 
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 Show State Using Background – Enable/disable background screen coloring. 

When enabled, the screen background is red when recording, green when 

cameras are live or recording is paused, and blue when saving. 

Show Bayer in Live Images – Display live images from color cameras with the 

Bayer filter applied for faster refresh rate. 

 

 Lens Calculator -- Compute focal length, magnification, object distance, and 

field width for each camera. 

 FPN & Black Level Correction – Recalibrate an XC-1 camera to automatically 

set the black level and correct fixed pattern noise (FPN).  

 Note: FPN & Black Level correction is not required for XC-2 cameras. 

 Color Correction – Select a camera, choose from preset values, adjust and 

store color conversion parameters, red-green-blue gains and offsets, smoothing 

functions, Auto Balance, and Grey Balance. 

 Camera Gains -- Set digital and analog gain values for XC-2 model cameras. 

 Image Processing – Set values for brightness, contrast, gamma, and 

exponential, or adjust input/output curves to improve video image quality. 

  

 Check for Updates – Check with the Xcitex website for the newest version of 

ProCapture software and download if necessary. 

 Note: The Check for Updates feature is described in detail in Chapter 1. 

 

About ProCapture -- Provides information about the software version, licensing 

terms, and technical support available for ProCapture. This dialog box also 

indicates the number of camera and data channels included with your 

ProCapture system. 
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Control Panel 

The ProCapture Control panel contains a series of buttons which define the configuration 

of your ProCapture system and determine whether or not the system is recording and 

what information is saved. 
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Configure    

Clicking the Configure button allows you to define program options, video and data 

acquisition settings, triggering options, and event save parameters. 

Note: Configuration settings are described in detail in Chapter 4. 

 

Stop / Idle     

Clicking the yellow button stops the current behavior of the cameras (recording or live 

display) and places the cameras into Idle mode. This button is only available if the system 

is currently in Live mode or recording. If Show Information is enabled, yellow text 

displayed in the camera panels indicates that the system is idle and recording is not taking 

place. 

  

Live / Arm    

Clicking the green button activates Live mode and arms the system to be ready to record. 

This button is disabled if the cameras are already in Live mode or Record mode. When in 

Live mode, the cameras stream live video to the screen, displaying real time events. Data 

acquisition devices are also live and displaying data on the screen. Green text displayed 

in the camera panels indicates that the system is live. Live images and data are not 

saved. 

 

Record    

Clicking the red button instructs ProCapture to start recording video. Red text displayed on 

the screen in the camera panels indicates that recording is taking place. The Event 

Trigger, Pause Recording, and Show Information controls are active while ProCapture is 

recording. 
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Event Trigger   

Clicking the Event Trigger button marks the spot on the video where an event has 

occurred. Each click increases the Event Count value in the Event window. If your system 

has data acquisition, each event trigger occurrence is indicated in the data window. 

Events can also be placed after a recording has already been completed. When in Idle 

mode, click in the timeline location where you would like an event, then click the Event 

Trigger button. 

 

Pause Recording    

Clicking the Pause Recording button pauses the recording. The cameras continue to 

display a live image; however, frames are not stored to memory. Pauses in the recording 

are displayed as grey segments in the timeline. This can be used to create a single 

recording that spans a long duration with some down time in between (for instance to 

reset equipment or prepare another test). If you use the Save Entire Recording function 

for a recording that contains pauses, the recording will be saved in parts to ensure precise 

video/data alignment when played back. You can also save a recording containing pauses 

as one large video by selecting this option when configuring your Event Save Settings. 

 

Save Single Frame   

Clicking this button saves the current live frame from each camera view to a file. This 

function is typically used to capture single-frame images to be used for scene calibration. 

This function is enabled in Live mode. 
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Save All Events   

Save All Events creates a project file and folder in the Captures folder for each event. For 

each triggered event, a fixed amount of time will be saved before and after each event 

marker. Each folder will contain two files for each camera, plus one additional file if your 

system includes data acquisition. If the "Prompt to select events to save" option is 

configured, clicking this button displays a list of events triggered during the recording 

session, each labeled with the event time and trigger type used. Checkboxes allow you to 

select/deselect the event(s) to be saved.  You can also save the range between 

sequential events, displayed as magenta bars in the timeline, if you select the option 

"Save ranges between sequential events" when configuring Event Save Settings. 

 

Save Entire Recording  

Clicking this button saves the entire buffer containing all recorded video and data since 

the record button was pressed. A dialog box reminds you that these files can potentially 

be very large. If you clicked the Pause Recording button during the recording, the video 

and data are saved in parts. The end of each part is determined by the location where the 

Pause Recording button was clicked. Optionally, you can save a recording containing 

pauses as a single video if you select "Save Entire Recording as one large video even if 

pauses are present" when configuring Event Save Settings. 

 

Erase Recording   

Clicking this button erases the cache files containing the current recording. Any events 

that have not been saved will be erased. Unsaved events are also erased automatically 

when a new recording is started. 
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Show Information   

Toggles the amount of information displayed as text on the screen in each panel. Text in 

each camera panel is displayed in green when cameras are live, yellow when idle, red 

when recording. 

 

 

 

 

 

 

 

 

 

  

Current Index 

Cache Use 

Max. Cache Use 

Frame Rate 

Resolution 

Exposure 

Sync Source 

Cache File ___ 

Written to Disk ____ / ____ frames 

________ -- Captured 

________ -- Remaining 

 

Displays the name of the cache file and disk 

where the video from this camera is being 

saved, as well as the elapsed recording time 

and time remaining for recording. 

Camera label 
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Touchscreen Controls 
 

ProCapture provides a set of controls specifically designed for touchscreen devices. To 

use the controls, start ProCapture using the ProCapture Touch shortcut on the desktop. 

For ease of use, the various buttons are arranged in a series of nested menus; however, 

they function in the same way as the standard controls. An arrow () indicates that there 

are additional menus nested under a function button. Touch the Back Arrow () button 

at the bottom to return to the previous level of menus at any time. Touch Exit to exit the 

program. 
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Panning and Zooming with Touchscreen Controls 
 

In the Touchscreen version of the software, the zoom, pan, and full screen display 

functions are performed with controls visible in the bottom right corner of the camera view. 

With these controls, you can do the following: 

• Touch the + and – to zoom in and out.  

 

• Touch the arrows (   ) to pan.  

 

• Click the square () to reset the display after zooming/panning. 
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Chapter 4.  Configuring a Recording 

 

Configure can be selected either from the File dropdown on the Menu bar or the Control 

panel. This selection gives you access to five panels where you can define specific 

parameters for your recording session: Program Options, Video Acquisition Settings, Data 

Acquisition Settings, Triggering Options, and Event Save Settings. You may also create 

and save customized configurations for specific users or testing situations. 

Program Options 

The Program Options panel is automatically displayed when you select Configure from the 

Control panel. 
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Record Mode 
Choose Synchronized Video or Synchronized Video And Data (if your ProCapture 

system includes data acquisition). 

Buffer Style 
One-Pass Buffer -- When ProCapture is recording, video frames and data are streamed 

directly to the Video Processing Unit. The finite amount of memory reserved for this 

purpose is called the one-pass buffer. When the buffer is full, the recording session ends. 

Circular Buffer – Unlike one-pass buffering which ends the recording session when the 

buffer is full, circular buffering continuously overwrites the oldest video and data so that 

the most recently recorded information is always available (first-in first-out principle). This 

process of recording in a continuous loop is called a circular buffer. As video and data are 

overwritten, events that occurred at the beginning of the recording session may be lost. 

For example, if you record for 2 hours, but your recording duration buffer equals 1 hour, 

only the events that occurred during the second hour will remain. Events that occurred 

during the first hour will have been overwritten. 

 

Options 
Start System With Cameras Live – If checked, system will start up with cameras in Live 

mode. 

Live Data Uses Scale And Offset -- If checked, data is displayed in the units specified for 

that channel using the scale and offset values specified for each channel. If not checked, 

data is displayed as raw voltage.  

Highlight Current Frame Data when Idle – If checked, a vertical green bar is displayed 

at the position in the timeline and data window indicating the current frame when 

ProCapture is in Stop/Idle mode. 

Live Data Graph Scrolls To Right – If checked, changes the direction in which the data 

graph scrolls. The default value is an unchecked box: newest data is typically shown on 

the right and the graph scrolls to the left. 

Background Color Indicates State – If checked, the screen background indicates the 

current state of the system: red when recording, green when cameras are live or recording 

is paused, and blue when saving. 

Show Information Level -- This option controls how much text is displayed in the camera 

panels. This dropdown menu allows you to select values ranging from 0 to 3. If you select 

0, no text will be displayed. The information level can also be changed while the program 

is running by clicking the Show Information button on the Control panel. 
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Show Bayer for Live Color Cameras – If checked, displays live images from color 

cameras with the Bayer filter applied for faster refresh rate. 

Live Update Rate – This slider controls the speed at which live images are updated on 

the screen. On slower systems the program may become unresponsive if the Live Update 

Rate is set too high. If this occurs, restart the program and immediately lower this setting. 

Video Acquisition Settings 

Click the Video icon from the Configure window to display the Video Acquisition Settings 

panel. 

 

 
 

 

Number of Cameras -- Allows you to select values ranging from 1 to the maximum 

number of cameras included with your ProCapture system. 

Frame Rate -- Allows you to select values ranging from 5 to either 500 or 1000 frames per 

second, depending on camera model. The default is 100. The frame rate affects the 

available resolutions and the maximum recording time. A low frame rate is recommended 

if your testing requires a long recording time. A higher frame rate results in a reduced 

recording time and also may reduce your maximum resolution. 
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Default Shutter Speed -- Determines the amount of time that the electronic shutter of the 

camera remains open during each frame. Shorter exposure times reduce blur within each 

frame, but at the expense of light collecting ability. The default value is slightly lower than 

1/frame rate microseconds. The value that you enter will apply to all cameras in the 

system. A procedure to set different shutter speeds for individual cameras will be detailed 

below. 

Default Resolution -- Allows you to select the default resolution for all cameras. 

Currently, all cameras in the system must have the same resolution. For each frame rate 

chosen, only certain resolutions may be available. Lower resolutions typically result in 

longer recording times and more video frames. 

 

Specifying Unique Settings for Each Camera 
The Video Acquisition Settings panel also contains a section with specific information for 

each camera connected to your ProCapture system. This listing allows you to configure 

each camera individually. Double-click on the camera whose settings you wish to change. 

In the Camera Settings dialog box you may change the device number, label, resolution 

width and height, shutter speed, and cache designation for that camera. Click Apply to 

update the settings, and then click Close. 

 

Note: ProCapture requires all cameras to have the same resolution, which is why the 

width and height may not be changed in this dialog box. 
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Data Acquisition Settings 

Click the Data icon from the Configure window to display the Data Acquisition Settings 

panel (if your system is enabled for data acquisition). The data acquisition hardware can 

record data from several sources during a data recording. The channels represent 

different streams of incoming data. 

 

 

 

Device Capabilities – Most configurations of ProCapture will only have a single data 

device installed. If multiple devices are installed in your system, more than one device will 

be listed here. Information about your selected device is shown on the right. 

Number of Channels -- Allows you to select values ranging from 1 to 32. The default is 8. 

Samples Per Frame -- The value entered here determines the number of data samples to 

take per frame of video. For example, if the video record rate is 100 frames per second, 

and the samples per frame is set to 10, then 1000 samples per second will be captured. 

Note: The product of samples/frame x frame rate x the number of data channels cannot 

exceed the maximum data sampling rate of your ProCapture system. 
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Live Samples to Display – The value entered here determines the number of samples 

that will be displayed in the live data view at the bottom of the main window. The default is 

1000. If the live data graph appears to move too quickly, increase this value. If it moves 

too slowly, decrease this value. 

Individual Data Channels -- This list shows the configured analog input data channels. 

Double-clicking each line in the list displays the Data Channel Settings popup menu, 

allowing you to customize the settings for each data channel. 

 

 

 

• Input: Specifies the hardware input that is associated with the channel. 

 

• Label: Allows you to name each channel. Assigning descriptive names (e.g., left wall, 

or strain) to the channels makes reviewing data easier. 

 

• Units: Engineering units after scaling (volts, g, psi, etc.) 

 

• Minimum: The lower limit, in volts, that you expect to see from your sensor. Using the 

tightest range that includes all possible sensor values you expect to encounter will 

improve your results. 

 

• Maximum: The upper limit, in volts, that you expect to see from your sensor. Using 

the tightest range that includes all possible sensor values you expect to encounter will 

improve your results. 
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• Scale: ProCapture applies a scale factor to convert the input volts to a meaningful 

number in engineering units. The scale factor is multiplied with the input voltage. 

 

• Offset: In units, the offset to be applied by ProCapture to account for offsets in the 

input. The offset is added to the scale factor-multiplied input voltage. 

 

• Color: The color that will represent the data channel in graphs can be changed by 

clicking on the current color and selecting from the color palette window. 

 

The maximum and minimum field values can range from -10 to 10. These specify the 

range of volts expected of the input. The closer this range is to the actual values, the 

better the digitization will be. 

The Scale and Offset values provide the parameters for a linear scale that is applied to 

input voltages on each channel. Each voltage value in the input data is multiplied by the 

factor, and then the offset value is added. Use the appropriate scale factor and offset for 

the sensor attached to the channel so that incoming raw values will be automatically 

scaled to engineering units. 

In the live view, each data channel is displayed at the bottom of the screen in text 

corresponding to the assigned color. 
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Triggering Options 
 

Click the Trigger icon to display the Triggering Options panel. ProCapture features five 

methods for triggering an event – the software Event Trigger button, the Space Bar key on 

the keyboard, external TTL trigger, data level triggering, and video triggering. The 

Triggering Options panel allows you to select and configure each triggering mechanism 

you wish to use during your ProCapture recording session.  

 

 

 

 

Note: Please refer to Chapter 5 for more information on Triggering Options. 
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Event Save Settings 

Click the Event Save icon to display the Event Save Settings panel. 

 

 

 

Save Folder  
Saves all captured events (video and data) to one folder. The Captures folder on the C:\ 

drive is the default; however, you may select a different folder to receive your captured 

events. The folder must exist on the system for the save operation to be successful. 

 

Save Range 
These values specify the number of seconds of video to save before and after each event 

(Pre-Event Save Duration and Post-Event Save Duration). They dictate the amount of 

time prior to the trigger and after the trigger is received that will be saved when saving all 

events. These values do not have to be the same. The default is 1.5 seconds for each. 
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The option Save ranges between sequential events allows you to save the segments of 

the recording that lie between sequential triggered events. This is useful if you want to 

press the trigger before and after an expected event occurs and save the entire duration 

between each pair of event triggers. If you select this option, the Pre-Event Save Duration 

and Post-Event Save Duration fields are grayed out. 

 

Save Format  
Type -- Allows you to choose from several standard file formats for your captures. The 

Type dropdown menu displays AVI, BMP, JPEG, TIFF, and PNG. Select AVI to save as a 

single video file; the other formats save a sequence of images. Compression for AVI files 

can be selected in the Options section below. 

Quality – The value entered here determines the compression rate for files in .jpeg 

format. The default is 75. 

 

Options 
Allow overlapping save segments (default) -- When this box is checked, ProCapture will 

save all event segments with the full pre- and post-save duration, even if the time gap 

between the events is smaller than the set pre- and post- save duration values. If the box 

is not checked, the length of some segments may be shorter than the specified values to 

avoid overlapping saved segments. Allowing overlapping save segments may consume a 

larger amount of disk space since some frames may be saved more than once into 

multiple overlapping events. 
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Prompt to select events to save – When this box is checked, ProCapture will display a 

list of events that occurred during the recording when the Save All Events button is 

clicked. Events are displayed in chronological order and each is labeled with time and 

trigger type information. Each event has a checkbox that may be cleared if you do not 

wish to save that particular event. If you elected to save ranges between sequential 

events, some event checkboxes are not selectable, because the "event" available to 

select actually represents the range between two sequential events. 

Save events with time set relative to start of recording (default) -- When this box is 

checked, ProCapture measures the elapsed time between events by referring back to the 

beginning of the recording session as t = 0. A checked box is the default for this option. 

Save Entire Recording saves as one large video – When this box is checked, 

recordings containing pauses are saved as one large file, rather than divided into parts 

coinciding with the times that the Pause Recording button was clicked. 

AVI Playback Rate in Windows Media Player -- The value you enter determines the 

playback speed of your video when played in conventional video players, such as 

Windows Media Player. The default is 25 frames per second. 

Video Compression -- This dropdown menu allows you to select from a number of 

compression codecs for AVI saving. Since all players may not be compatible with some 

video compressors, and compression can result in loss of quality, we recommend that 

videos be saved as Uncompressed (default). The codecs listed here are installed on your 

computer. These codecs are not a part of ProCapture, and some may be incompatible. 
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Saving, Loading, and Default Settings 

When you launch ProCapture, the program uses the values that were set in each 

configuration panel during the previous session. If you would like to set up different 

configurations for specific users or various types of testing, you can create, save, and load 

customized configurations for these situations. The buttons at the bottom of the Configure 

panel allow you to change the default values or save configuration settings. 

 

 

 

 

Load -- Load a ProCapture configuration from an existing file. 

Save -- Save the current ProCapture configuration as a file. 

Default -- Sets the current configuration of ProCapture to use the default settings defined 

at the last use of "Set As Default." 

Set As Default -- Applies your changes; sets them as new default values to be used when 

the Default button is pressed. 
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Chapter 5.  Capturing Events 

 

An event is a section of a video that is marked by a triggering mechanism (external 

hardware hand switch trigger, video trigger, data level trigger, software Event Trigger 

button, Space Bar key). ProCapture allows you to determine the amount of video to save 

before and after each triggered event. 

 

This chapter discusses all the processes involved in event capture. Topics include: 

• Configuring your ProCapture system for long recording 

• How ProCapture collects data 

• ProCapture's five triggering mechanisms 

• Triggering an event from the timeline 

• How ProCapture saves events 

• Changing the amount of video included before and after a saved event. 

 

Duration Basics 
 

The maximum duration of your recording is determined by the frame rate and resolution 

you select when configuring your recording. 

 

Frame Rate, or frames per second (fps), indicates the number of frames in each second 

of recorded video. 

Resolution indicates the number of pixels (width x height) contained in a digital image. A 

higher resolution creates a sharper and more detailed image. 

Under certain conditions, ProCapture can record for up to 5 hours. The charts on the 

following pages show some examples that illustrate the relationship between the length of 

ProCapture's recording time, frame rates, and resolutions for a standard system. Special 

configurations may have different record times. 
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Frame Rate Resolution Record Time 
(minutes) 

30 
frames/sec 

1240 x 1080 203 

1240 x 900 240 

1240 x 720 300 

1150 x 960 251 

1050 x 1000 255 

60 
frames/sec 

1240 x 1080 102 

1240 x 900 120 

1150 x 960 125 

1050 x 1000 131 

100 
frames/sec 

1240 x 1080 61 

1240 x 900 72 

1150 x 960 75 

1050 x 1000 79 

150 
frames/sec 

1240 x 1080 41 

1150 x 1080 44 

1050 x 960 54 

960 x 1080 53 

200 
frames/sec 

1240 x 900 37 

1150 x 960 37 

1050 x 960 41 

960 x 960 45 

300 
frames/sec 

1240 x 600 37 

1150 x 640 37 

1050 x 700 37 

960 x 770 37 

400 
frames/sec 

1050 x 520 37 

960 x 570 37 

860 x 630 37 

760 x 710 37 

500 
frames/sec 

1050 x 410 38 

960 x 450 38 

860 x 500 38 

760 x 560 38 

 

 

XC-1 Camera -- Sample Frame Rates, Resolutions, and Record Times 
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Frame Rate Resolution Record Time 
(minutes) 

60 
frames/sec 

1920 x 1080 64 

1680 x 1080 74 

1152 x 864 135 

900 x 900 166 

720 x 1080 173 

100 
frames/sec 

1920 x 900 46 

1260 x 1080 59 

1152 x 900 77 

900 x 900 99 

720 x 1080 103 

150 
frames/sec 

1920 x 600 46 

1260 x 1080 39 

1152 x 864 54 

720 x 720 103 

250 
frames/sec 

1920 x 360 46 

1152 x 720 38 

720 x 360 124 

500 
frames/sec 

1920 x 180 46 

1260 x 360 35 

600 x 720 37 

 

1000 
frames/sec 

 

1920 x 84 50 

900 x 174 51 

600 x 350 38 

 

XC-2 Camera -- Sample Frame Rates, Resolutions, and Record Times 
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Data Acquisition Basics 
 

ProCapture data acquisition has been designed to work with a large number of different 

types of transducers. These sensors convert force, rate of flow, pressure, temperature, 

etc. into a voltage (volts) that is proportional to the physical parameters being monitored. 

Typical sensors include: 

 

• Accelerometers 

• Microphones  

• Strain Gauges 

• Flow Sensors 

• Pressure Sensors 

• Thermistors 

• Hydrophones 

• Dynamometers 

• Speedometers 

• Tachometers 

Often, signals from these sensors must be amplified, filtered, biased, converted from 

current to voltage, or processed in other similar ways. Therefore, each sensor type 

typically uses a signal conditioner, designed specifically for that type of sensor, to produce 

signals recognized by the ProCapture data acquisition hardware. ProCapture uses voltage 

variations on the data lines to determine data values, so any signal conditioner that 

outputs a voltage can be used. 

Note: For more information on data acquisition, refer to the National Instruments website: 

www.ni.com. 
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Triggering 
 

Events are triggered with one of the following five methods: the software Event Trigger 

button, the Space Bar key on the keyboard, external hand trigger device, data level 

triggering, or video triggering. Triggering with any of these mechanisms produces an event 

marker on your video. The Triggering Options panel displays all of the triggering options 

available for your ProCapture recording session.  

ProCapture creates video clips of each event using the Pre-Event and Post-Event Save 

Duration values you configured in the Event Save Settings. Typically, an experiment may 

cover a long period of time, with events of interest only occurring here and there. The 

combination of triggering and save duration settings lets you view the events without 

having to view or save the entire recording. 

 

 

 

Software Trigger Button – Trigger an event by clicking the Event Trigger button on the 

Control panel. 

Keyboard Space Bar – Trigger an event by pressing the Space Bar key on the keyboard. 
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External TTL Input (Rear Panel BNC) – Trigger an event with an external device, such 

as a hand switch routed through a trigger box. 

Data Level Triggering on Channel # -- If the box is checked, this dropdown menu allows 

you to select values ranging from 1 to the number of channels being recorded. An event is 

automatically triggered if the data being recorded meets the voltage limits configured for 

data level triggering on the selected channel. If the box is not checked, the signal on any 

data line will not trigger an event.  

Data Level Trigger Settings – Clicking this button displays the Data Trigger Settings 

dialog, allowing you to specify limits for voltage and elapsed time before another event is 

triggered.  

Video Triggering on Camera # -- Checking this box activates the dropdown menu, 

allowing you to select the camera view where video triggering will take place. Only one 

camera may be selected.  

Video Trigger Settings – Clicking this button displays the Video Trigger Settings dialog, 

allowing you to specify the size of the video trigger region, the conditions that must be met 

for triggering in the selected camera view, and the minimum amount of time that must 

elapse before the next triggered event.  

 

 

Data Level Triggering 
 

ProCapture can be configured to automatically trigger itself based on the voltage value on 

a specified data line. You might use this to automatically trigger your system when the 

force on a force plate exceeds a certain value or if a line break sensor was tripped, for 

example. A data level event is automatically triggered if the data being recorded from a 

sensor meets the user-specified requirements for Data Trigger Settings. 

 

Set Up Data Level Triggering 
 

ProCapture can automatically mark event triggers using the voltage readings from one of 

the recorded analog channels. This is called “Data Level Triggering”, since the system is 

triggered by data values that exceed or fall below a certain level. ProCapture can be 

configured to look for rising or falling edge signals at user-configurable voltage levels. A 

minimum time value between trigger events can also be set in order to prevent multiple 

triggers within a short period of time.  
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To set up a channel for data level triggering, check the box labeled Data Level Triggering 

on Channel # in the Triggering Options panel. The channel used for data level triggering 

must be configured as one of the recorded channels. Select the channel to enable for data 

level triggering from the dropdown menu next to the checkbox. 

 

 

 
 

 

Click the Data Trigger Settings button to set the parameters for determining when a 

trigger event occurs. The Data Level Trigger Settings window appears, allowing you to 

specify specific voltage values for event triggering and a minimum time that must elapse 

before another event is triggered. 
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If you wish to trigger on rising edge signals, check the Rising Edge – Voltage Exceeds 

checkbox and enter a voltage value in the box to the right. If you wish to trigger on falling 

edge signals, check the Falling Edge – Voltage Falls Below checkbox and enter a 

voltage value in the box to the right. Both rising edge and falling edge can be used 

simultaneously and ProCapture will trigger on both conditions. Enter a value for Minimum 

Time Before Next Trigger Event to prevent additional trigger events from occurring too 

close together. 

 

 

Video Triggering 
 

ProCapture can automatically mark event triggers in response to changes in the view of a 

single camera. With video triggering, the system is triggered by conditions that exceed or 

fall below a certain average intensity level. ProCapture can be configured to look for rising 

or falling edge conditions and increasing or decreasing intensities at user-configurable 

levels. A minimum time value between triggered events can also be set in order to prevent 

multiple triggers within a short period of time. Optional smoothing may be applied to the 

triggering values to smooth out noise and a live graph may be displayed.  

 

To set up video triggering, click the Trigger icon to display the Triggering Options panel. 

Check the box labeled Video Triggering on Camera #. Select the camera to enable for 

video triggering from the dropdown menu next to the checkbox.  
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Click the Video Trigger Settings button to set the parameters for determining when a 

trigger event occurs. The Video Trigger Settings window appears. 

 

 
 

 

 

Specify the Width and Height (in pixels) of the region that ProCapture will search for 

video triggers. 

 

If you wish to trigger on rising edge conditions, check the Rising Edge – Mean Value 

Exceeds checkbox and enter a mean value (0 – 255) in the box to the right. If you wish to 

trigger on falling edge conditions, check the Falling Edge – Mean Value Falls Below 

checkbox and enter a value in the box to the right. Both rising edge and falling edge can 

be used simultaneously, and ProCapture will trigger on both conditions.  

 

If you wish to trigger on changes in intensity, check the Mean Value Increase from Last 

Value checkbox and/or the Mean Value Decrease from Last Value checkbox and enter 

a value in the box to the right. Both increase and decrease can be used simultaneously, 

and ProCapture will trigger on both conditions. Enter a value for Minimum Time Before 

Next Trigger Event to prevent additional trigger events from occurring too close together. 
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If the video intensity values are noisy and you need a smoothed value to ignore the noise, 

check the Apply Smoothing To Mean Values checkbox in the Options panel and enter a 

smoothing value if desired. A value of 0.1 applies heavy smoothing; a value of 1.0 applies 

no smoothing. If you would like to see a live graph of the mean values, click the Display 

Live Mean Value Graph checkbox. Enter the Update Rate for the graph. The update rate 

cannot exceed the frame rate configured for recording. The recommended update rate is 

25 Hz. 

 

After you have finished entering all video trigger settings, click OK. A box will appear in 

the selected camera view. The box can be repositioned anywhere in the camera panel to 

achieve best placement for video triggering. In Live mode, reposition the region by holding 

down the Ctrl key and clicking the left mouse button. 

When video triggering occurs during recording, the graph displays the trigger event. The 

red lines in the graph represent the trigger threshold values entered in the Video Trigger 

Settings window, and the blue graph line shows the triggering data. The number of video-

triggered events during the most recent recording session appears in the lower right 

corner of the video trigger region. A video trigger event appears on the timeline as a cyan 

segment with the letter V above the segment. 
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Triggering Events within the Timeline 
 

The timeline displays the time from start to finish of the recording. If events have been 

triggered during the recording session, a segment of the timeline is shown in a specific 

color with a letter above the segment indicating the triggering method. The table below 

shows the types of triggered events displayed on the timeline.  

 

Letter Segment Color Trigger Type 

S Green Software (control panel) 

K Orange Keyboard (Space Bar) 

E Magenta External (hand switch) 

D Yellow Data Level 

V Cyan Video 

 

When recording is finished, you can click in the timeline. You will see the frames 

corresponding to the current location in the video for the current time displayed in the 

timeline. If events were missed during the recording, you can now create additional trigger 

events within the timeline by moving the cursor to the desired location and clicking Event 

Trigger. A dialog box requests confirmation that you would like to add a software event at 

that location. Click Yes. A green segment with the letter S above it appears at the timeline 

location. 

If you notice that something of interest occurred outside of a saved event segment, click 

on the location of interest in the timeline. Click Configure and Event Save and add the 

additional time to the pre- or post- event save duration.  

Events cannot be removed from the timeline.  

 

Note: The live data graph is updated to show the corresponding data. 
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Changing the Save Range after Recording Complete 
 

After viewing your captured events you may decide you would like to save more or less 

video before and/or after each event marker.  

1. Click Configure and then Event Save. 

 

2. Under Save Range, change the number of seconds for Pre-Event and/or Post-

Event Save Duration as desired. 

 

3. Click OK. 

 

 

 
 

 

4. If no other configuration settings were changed, the system will not prompt to 

reinitialize the cameras. If you are prompted to reinitialize the system, click No. 

 

5. From the Control panel, click Save All Events. 

 

6. When you return to ProAnalyst or ProViewer to view your events, the newly 

saved events will include the updated save duration.  
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Overlapping Event Saves 

Because some captured events may occur within a brief timeframe, ProCapture allows 

you to save overlapping events using the pre- and post-event save durations you specified 

on the Event Save Settings panel by checking the box for the Allow overlapping save 

segments option. If this option is not enabled, the save durations of some video segments 

will be truncated if the events occur close together. 

 

 

 
 

 

 

The graphic on the following page shows three events. The horizontal axis is time. The 

colored areas are the pre- and post-event save times. You can see that the triggered 

events and save durations cause Events 2 and 3 to overlap. 
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Overlapping save segments 

 

 
  

 

 

 

 

 

 

Non-overlapping save segments 

 

 
 

 

 

 

 

 

When saving with overlapping save segments, the frames from the overlapping portions 

are saved twice, once in Event 2 and once in Event 3. 
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Select Events to Save 

ProCapture provides a configuration option to select some or all of your triggered events 

to save when a recording is completed. In Event Save Settings under Options, click the 

checkbox next to "Prompt to select events to save."  

 

 

If this option is selected, clicking the Save All Events button after recording displays the 

Select Events to Save dialog, as shown below. Click the appropriate checkbox(es) to 

select  the listed events, which are labeled with the time and trigger type. Click OK to 

confirm the selection. If you would like to add more events at this time, you can click in the 

timeline to trigger, then click Save All Events again to view the updated list of events. 
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If you also selected the Save ranges between sequential events option along with 

Prompt to select events to save, some events in the Select Events to Save dialog are  

not selectable. The "events" that are available for saving actually represent the ranges 

between two sequential events, not the events themselves. 
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Chapter 6.  Analyzing, Viewing, and Sharing 

Captured Events 

 

After you have successfully recorded and saved events, you can review them and perform 

analysis using the ProAnalyst software included with your ProCapture system. You can 

also view and share your results using ProViewer software. 

How Events Are Saved 

ProCapture creates ProAnalyst project files with the extension .mpj for each saved event 

(or range between sequential events). These project files contain links to videos from each 

camera (.avi, .bmp, .jpeg, .tiff, or .png). The project files are saved in the Captures folder. 

In addition to the project files, there is an .ini information file and folder for each event. 

Each folder contains a video file, a configuration file, plus one data file if your ProCapture 

system includes data acquisition. 

 

The project files, event folders and files are named as follows:   

 

<Date>_<Time>_Evtxx 

 

where "xx" represents a specific event number. For example, the event folder 

named: 

 

  2012-05-23_09-15_Evt03  

 

contains the files for event number 3, captured at 9:15 a.m. on May 23, 2012. 

 

 

For single frame captures, the folder and file names appear as:   

 

<Date>_<Time>_Single 

 

For example:  2012-05-23_09-15-32_Single 

 

Note that the single frame capture filenames also include seconds in the time 

portion of the name. 
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When entire recordings are saved, the folder and file names will be:  

 

<Date>_<Time>_Entire 

 

For example:  2012-05-23_09-15_Entire 

 

 

When an entire recording has been saved and the recording contains pauses, 

ProCapture saves the recording in parts. The folder and file names appear as:  

<Date>_<Time>_Entire-Partx 

 

where "x" represents a part of the recording between pauses.  

 

For example:  2012-05-23_09-15_Entire-Part1 

 

The chart below and the illustration on the next page show the Captures folder naming 

conventions and layout. 

 

 
Save Method 

 

 
Name Format 

 

 
Example Name 

Event <Date>_<Time>_Evtxx 2012-05-23_09-15_Evt01 

Single <Date>_<Time>_Single 2012-05-23_09-15-32_Single 

Entire <Date>_<Time>_Entire 2012-05-23_09-15_Entire 

Entire with pauses <Date>_<Time>_Entire-Partx 2012-05-23_09-15_Entire-Part1 
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Viewing, Sharing, and Analysis 
 

Run ProAnalyst if you wish to view and analyze the project files of your captured events.  

 

To view and/or share the videos, use ProViewer software. ProViewer allows you to open 

and play back ProAnalyst project files; however, you cannot perform tracking or 

measurements on the videos. ProViewer is available as a free download from the Xcitex 

website. 

 

ProAnalyst and ProViewer allow you to open ProCapture files directly from the File menu 

by selecting Open from ProCapture, as shown below. 

 

 

 

 
 

 

 

 

Note: For more information, please refer to the ProAnalyst User Guide. 
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Chapter 7.  Advanced Topics 

 

This chapter explains some procedures that you may perform infrequently or only when 

setting up ProCapture for the first time. 

Capture Single Images for Calibration 
 

Performing 2-D or 3-D calibration in ProAnalyst requires a single image of a calibration 

object from each camera. The Save Single Frame button in ProCapture allows you to 

easily capture a single frame from each camera and save the results in a ProAnalyst 

project. 

 

To capture calibration images, put the cameras into Live mode by clicking on the 

Live/Arm button. For 2-D calibration, place an object of known length into the field of view 

of each camera. The object should be placed so that it lies in the same plane of motion as 

the action you will be recording. The calibration object should be as large as possible and 

occupy as much of the field of view of each camera, while still being completely visible. 

When the object is entirely visible by all cameras, click on the Save Single Frame button. 

For 3-D calibration, place a calibration fixture into the field of view of each camera. Make 

sure that all points on the calibration fixture are visible in each camera's field of view. Click 

Save Single Frame to save the current live images. 

 

The resulting single frames will be placed into a folder within the Captures folder that you 

set in the Event Save Settings panel of the Configure window. The folder will be named 

using the format <Date>_<Time>_Single (for example, 2012-09-12_09-15-32_Single), and 

a ProAnalyst project file with the same name as the folder will be created in the Captures 

folder. 
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Recover the Most Recent Recording Stored in Cache 
 

The most recently completed recording is stored on the cache drive(s) until another 

recording is started or the Erase Recording button is clicked. It is possible to retrieve 

events from the last recording or the entire last recording even if you have exited the 

ProCapture program or shut down the computer. 

 

To save portions of the most recent recording, the video and data configuration settings 

should be the same as when the recordings in the cache were captured. As long as you 

have not modified the configuration since the last recording, ProCapture should restart 

with the same settings you had last used. If you have recently changed the configuration, 

change the values back before attempting to recover the last recording. If you do not 

remember the settings that you used, you can try to recover frames by playing back 

directly from the cache files, as described in the next section. 

 

If you are certain that the configuration is the same as when the recording was performed 

when restarting ProCapture, click Stop/Idle and the timeline should reflect the last 

captured recording. Now you can click Save Entire Recording or Save All Events to 

recover the last recording. 

 

 

 

 

 

Play Back the Most Recent Recording from the Cache 
 

ProAnalyst and ProViewer are capable of reading the ProCapture cache files directly. 

Although not recommended, this method can be used to recover portions of your 

recording in case of an unexpected failure. Some triggering and buffering information may 

be lost when reading the cache directly, especially if you are using circular buffering. 

 

To open the cache file, run ProAnalyst or ProViewer and select File ► Open Video\Data 

from the main toolbar. Navigate to one of the camera cache drives (drive letters E: - L:) 

and open the *.xpc file. If the last recording was also recording analog data, the data will 

be stored in the same cache drive as the first camera. Opening the camera *.xpc file for 

the first camera will also open the associated data, if present. 

 

Note: If the recording was paused or if the last recording was configured to use circular 

buffering, gaps from pausing or the looping from circular buffering will not be reflected in 

the frame numbering shown by ProAnalyst or ProViewer. 
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Chapter 8.  Troubleshooting 

 

This chapter provides solutions to some problems that you may encounter when using 

ProCapture.  

 

Data acquisition is not working 
 

Verify that the Data Acquisition hardware is working properly. Go to the Start menu and 

select All Programs ► National Instruments ► Measurement & Automation. In the 

window that appears, expand Devices and Interfaces. Find the device that you are trying 

to use for recording and right-click on the device. Select Test Panels from the dropdown 

menu. In the Test Panels window, perform the basic test of analog data acquisition to 

ensure that the device is working properly. If your device does not show up in the list of 

Devices and Interfaces or fails the recording test in the Test Panels, please contact Xcitex 

for support. 

 

If you have more than one data device, verify that the device selected in the Data 

Acquisition Settings configuration panel in ProCapture is the same device you intend to 

use for acquisition. 

  

System is not registering event trigger signals 
 

If you are using a hardware trigger switch, make sure that the trigger is connected to the 

proper location on the system. Refer to the "Connecting the Trigger Box and Hand Trigger 

Switch" diagram in Chapter 1. 

 

If you are recording video only, the system expects to receive a rising edge signal that 

goes from 0V to at least 3.3V. The ProCapture system is supplied with a trigger box that 

converts a hand-switch trigger to a voltage signal. The hand trigger switch should be 

connected to the input of the Trigger box. The output from the Trigger box should be 

connected to the back of the computer as described in Chapter 1. 

 

If you are recording video and data without Data Level Triggering, the trigger switch 

should be connected in the same way as described for recording video only above. 
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If you are recording video and data with Data Level Triggering, the voltage values you 

entered in the Data Level Trigger Settings window for the data channel you have selected 

will cause trigger events to occur. 

 

If you are clicking the Event Trigger button in the software Control panel or pressing the 

Space Bar key, and the Event Count does not increase, please contact Xcitex for support. 

 

 

Error message: “An error occurred while starting live 

preview.” or “An error occurred while waiting for frame from 

camera.” occurs when cameras are going live 
 

This error may occur infrequently when starting up your ProCapture system. If you see 

this message, click on Stop / Idle and then Live / Arm and the cameras should display a 

live image without an error message. If the error message occurs again, verify that all 

camera cables are connected securely and that all cameras are powered. If you are using 

fewer than the maximum number of cameras possible, please ensure that the cameras 

you are trying to use are connected to the proper ports on the back of the system. Refer to 

the "Connecting the Cameras" diagram in Chapter 1. If you continue to see these error 

messages, contact Xcitex for support. 

 

 

Error message: “Hardlock not found. Unable to start program. 

Please ensure the proper hardlock is attached.” on startup 

 
The ProCapture system requires a security key (hardlock) or a software license to 

operate. If you see this message, please verify that the security hardlock supplied with 

your system is plugged into a functioning USB port on the computer. If the hardlock and 

drivers are loaded properly, the red LED light inside the hardlock should be on. If the light 

is not on, try unplugging the hardlock and re-plugging it back into a different USB port on 

the computer. If the hardlock light is still not on, contact Xcitex for support. 

 

If your system did not come with a USB hardlock, it is using a software security key. If 

ProCapture will not start when using a software security key, please contact Xcitex for 

support. 
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Error message: “The previous recording resulted in a high 

additional cache use for Camera xx. This may indicate that 

frames were dropped during the recording. Please verify that 

the cache drives are set properly and exit and other programs 

that may be running in the background that may affect system 

performance.” 

 
This error indicates that at some moment in the recording, the system was not able to 

store images fast enough. At one or more points in the recording, there may be missing 

frames. Your saved events may not be affected. Save All Events will function properly as 

long as the missing frames do not overlap with your save event ranges. 

 

To remedy this situation, ensure that your system is configured properly so that each 

camera is streaming to one of the cache drive letters (E: - L:). Also, please close any other 

programs that are running while performing a recording. If the problem persists, please 

contact Xcitex for support. 
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About ProCapture, 33 

Application Look, 32 

Auto Balance, 27, 33 
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Bayer filter, 33, 43 

Buffer style, 42 
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Camera gains, 28, 33 

Camera settings, 44 

Camera views, 26 

Cameras, 1, 3, 5, 43, 44 
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Circular buffer, 42, 74 

Codecs, 51 

Color Conversion Parameters, 27, 33 

Color Correction, 27, 33 

Compression, 50, 51 

Configuration, 41–52 

Configure, 14, 32, 35, 41, 52, 64 

Control Panel, 34–38 

D 

Data Acquisition, 3, 4, 30, 45, 56, 69, 75 

Data Acquisition settings, 45–47 

Data Channel settings, 45–47 

Data channels, 30, 45, 46 

Data Collection hardware, 2, 4, 45, 56 

Data graph, 26, 30, 42 

Data Level Trigger settings, 58, 59, 76 

Data Level Triggering, 58–60, 75 

Defaults, 52 

E 

Erase Recording, 37 

Error messages, 75–77 

Event count, 17, 25, 30, 36, 76 

Event Save duration, 15, 21, 49, 57, 64 

Event Save settings, 15, 18, 64–67, 64–

67 

Event Trigger, 17, 36 

Event types, 57, 63 

Examples 

Video, 14–19 

Video/Data, 19–22 

F 

File formats, 50 

File naming conventions, 71 

FPN & Black Level Correction, 33 

Frame rate, 15, 20, 43, 44, 45, 53 

G 

Grey Balance, 27, 33 

H 

Hand trigger switch, 3–7, 75 

Hardlock, 76 

Hardware connections, 3–7 

Highlight Current Frame Data when Idle, 

42 

I 

Idle mode, 35 

Image Processing, 29–30, 33 
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Input/Output curve, 30 

Installation, 10–12 

L 

Lens calculator, 33 

Live Data Graph Scrolls To Right, 42 

Live Data Uses Scale And Offset, 42 

Live mode, 22, 35, 42 

Live Samples to Display, 46 

Live Update Rate, 43 

Load, 52 

M 

Menu bar, 32 

N 

Non-overlapping Save Segments, 66 

O 

Offset, 47 

One-Pass buffer, 42 

Overlapping Event Saves, 65–66 

Overlapping Save Segments, 50, 65, 66 

P 

Pan, 26, 32, 40 

Pause Recording, 36 

Play Back recording from cache, 74 

Playback rate, 51 

Pop-out Camera View, 26, 32 

Post-Event Save duration. See Event 

Save duration 

Pre-capture considerations, 13 

Pre-Event Save duration. See Event 

Save duration 

ProAnalyst software, 1, 2, 3, 8, 13, 69, 

72 

ProCapture software, 1, 3, 8, 10, 25–38 

ProCapture window, 25 

Program Options, 15, 41–43 

ProViewer software, 2, 9, 69, 72 

R 

Record, 17, 35 

Record mode, 42 

Recording duration, 53–54 

Recover recording from cache, 74 

Reinstalling ProCapture software, 10–12 

Resolution, 3, 15, 20, 43, 44, 53 

S 

Samples Per Frame, 45 

Save, 52 

Save All Events, 18, 37, 67, 77 

Save Entire Recording, 37 

Save folder. See Captures folder 

Save Range, 19, 64 

Save ranges between sequential 

events, 31, 37, 50, 51, 68 

Save Single Frame, 36, 73 

Scale factor, 47 

Select Events to Save, 51, 67 

Sharpening, 27 

Show Information, 35, 38, 42 

Show state using background, 33, 42 

Shutter speed, 15, 20, 44 

Smoothing, 27, 30, 33 

Software, 8–12 

Start System With Cameras Live, 42 

Status bar, 31 

T 

Test Panels, 75 

Timeline, 31, 32, 36, 42, 63, 74 

Title bar, 31 

Toolbars, 31–33 

Touchscreen controls, 39–40 

Trigger box, 3–7, 75 
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Trigger types, 57, 63 

Triggering, 31, 53, 57–63 

Triggering in Timeline, 63, 67 

Triggering options, 48 

Troubleshooting, 75–77 

U 

Updates, 9, 11 

V 

Video Acquisition settings, 15, 43–44 

Video example, 14–19 

Video Processing Unit (VPU), 3–7, 8 

Video Trigger settings, 58, 61–62 

Video Triggering, 58, 60–62 

Video/Data example, 19–22 

Voltage, 6, 42, 45–47, 56, 58–60, 75 

VPU. See Video Processing Unit (VPU) 

X 

xpc file, 74 

Z 

Zero time, 51 

Zoom, 26, 32, 40 
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